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ABSTRACT

Satellite navigation has been used for in-field applications by the Finnish Centre for Radiation and
Nuclear Safety since 1993. Because of this experience, training in the use of GPS positioning and
desktop mapping was chosen as a task under the Finnish Support programme to IAEA safeguards.
A lecture and a field experiment was held in the training course on environmental monitoring at the
IAEA headquarters in June 1995. Real-time mapping of the co-ordinates and storing information on
sampling sites and procedures can make safeguards implementation more efficient and effective.
Further software development are needed for these purposes.
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FOREWORD

Pilot training course on environmental monitoring

Overview:

This session deals with the use of Global-Positioning Satellite receiver technology to provide accurate
position (latitude and longitude) information which can be used to locate environmental sampling
points in the field. The topics which will be covered include:
1. Description of the GPS system and receiver technology.
2. Discussion of the types of maps and geographical data available and how desktop mapping

can be used to manipulate such data.
3. Use of GPS/PC techniques to navigate to the next sampling point and logging of sampling

data.

Objectives:

After the session, the participant will be able to:
• Describe the principles of GPS positioning and desktop mapping.
• Describe the use of a GPS system for locating and logging sampling points in an environmental

monitoring campaign.
• Describe the sources of maps and geographical data for use with desktop mapping software.
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1 INTRODUCTION

Satellite navigation is a simple method to digital maps for many applications. An advanced
determine current position anywhere in the world, user of a mapping software can also handle the
When the satellite navigator data is displayed production of digital maps, starting from high-
using a computerised mapping system, anyone quality printed maps,
can easily spot the location exactly. Portable
computers and tiny satellite navigators enable use A satellite navigation system, known as SAHTI,
of satellite navigation system in the field. was produced in STUK for real-time navigation

and environmental measurements. It includes a
A suitable map of the area of interest is the key GPS -receiver and a LapTop computer, equipped
of successful navigation. During the last couple with tailored software above a commercial
of years, the production of digital maps has mapping package,
increased and now it is possible to purchase
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2 GPS - SATELLITE NAVIGATION

The Global Positioning System (GPS) is a
satellite navigation system designed, built and
controlled by the US Department of Defence. The
GPS system is based on 24 satellites which circle
the earth at an altitude of 20,000 km. These
satellites are controlled by the Ground Control
Segment of the system. It's main tasks are to
calculate new parameters of the satellite orbits
and to correct the satellite clocks. The exact time
is essential for the whole system, since the
positioning is based on measurement of time
delays in signals from satellites down to earth. A
successful navigation requires that the receiver
can "see" at least 3 satellites. However, a position,
which is calculated from signals from 4 or more
satellites gives higher accuracy.

To utilize the GPS system, the user needs a GPS
receiver, which picks up the satellite signals and
calculates current position. The accuracy of 100
metres (95 % probability) is available for all users

(C/A code, civil code), whereas the US military
can reach an accuracy of 10 metres (P code,
military code). Accuracy of C/A code is usually
enough for navigation and environmental
monitoring. For special purposes higher accuracy
can be achieved locally by utilizing differential
correction techniques. In some countries, e.g. in
Finland and Sweden, a radio-transmitted signal
is available, and thus an accuracy of 2 m is
possible even in real-time applications.

GPS receivers are of different sizes, from a
PCMCIA card up to briefcase-size models. The
smaller instruments arc less precise, but still
useable for navigation and for visualisation of
environmental monitoring data. GPS receivers
return the current position in longitude-latitude
coordinates based on WGS-84 datum (World
Geodetic System). In most GPS -receivers
position data can be passed into a computer using
a serial interface. Figure 1 shows the GPS system.
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24 satellites

Users Control station

Figure 1. GPS system.



FINNISH CENTRE FOR RADIATION
AND NUCLEAR SAFETY STUK-YTO-TR 88

3 DESKTOP MAPPING

3.1 Maplnfo for Windows

Desktop mapping software is a powerful tool for
presenting data which has geographical signi-
ficance. Data points are displayed on a digital
map with exact location. In addition to normal
data analysis, Desktop Mapping offers geo-
graphical analysis (measuring distances, areas
etc.). It is possible for the user to spot and display
the location on earth correctly from the position
data of the satellite navigator. This, however,
requires that a high quality digital map is used as
a base map.

A desktop mapping software, known as Maplnfo
for Windows, was selected for the SAHTI system.
Maplnfo is not capable of navigation by itself.
However, Maplnfo is fully programmable
through the MapBasic-language.This enables the
user to produce customised applications utilizing
all Maplnfo's functions.

3.2 Base maps and coordinate
systems

Maplnfo for Windows can handle both major
types of digital maps, vector maps and raster ima-
ges. Vector maps consist of individual objects,
like lines, regions etc. Vector maps are stored on
disk in special Maplnfo format. Raster Images
are standard picture files (TIFF, BMP, GIF etc.).
Both types of maps are commercially available.
The best way to find them is to ask the local
National Survey Board for advice. The com-
mercial suppliers for digital maps can also help
to find Maplnfo compatible maps.

Once a plane map is created, a mathematical
model, known as projection (Transverse Mer-
cator, Lambert etc.), is used to transform the
locations of features on the earth's surface to
locations on a two-dimensional map surface. A
coordinate system is created by specifying the
parameters for the projection used. One of the
parameters is known as datum (WGS-84, ED-
50, ED-79). It defines which ellipsoid is used as
well as the location of the origin. An ellipsoid

estimates the shape of the globe. When a digital
map is being selected for a base map, it would be
desirable to find out the coordinate system of the
original map.

Coordinates returned from GPS will rot show
the correct position on the map if the coordinate
system of the map is not based on WGS-84 (the
difference may be hundreds of metres). There are
mathematical conversion formulas defined to
transform coordinates from one system into
another. The accuracy is a few mm. However,
these formulas include usually very complicated
mathematical functions. Since the accuracy of
GPS is only 100 m, a more simple method for
coordinate correction should be used. SAHTI
system can only perform mathematical cor-
rections between Finnish co-ordinate systems.
Therefore, in global use the correction must be
performed in another way. See section 4.3.

3.2.1 Vector map as a base map

Vector maps are usually produced from printed
paper maps using a special digitizing table.
Maplnfo handles vector maps as database tables
where one column in a data record refers to a
geographical object (poly line, region, symbol
etc.), that corresponds to a real feature on the
earth's surface. A data record can therefore
contain information about the object (inhabitants
of the town, number of houses etc.). Vector maps
are especially useful when large areas are viewed.
They can also be re-sized on the screen without
any limits. However, inaccuracies and "shortcuts"
in digitizing become disturbing when the map is
zoomed down to the finest details.

A wide range of vector maps is commercially
available. The accuracy of these maps depends
on the material they have been produced from
and on the person who has performed the
digitizing. The price of these maps is also relative
to the accuracy of a map. Maplnfo allows the
user to change the coordinate system of a vector
map. Disk space and memory of the PC determine
the level of details on a map, since every detail is

10
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a single drawn object. Maplnfo can show several
vector map layers simultaneously and also include
or exclude layers when a map screen is re-sized.

The user can also define his own coordinate
systems for Maplnfo. This, however, requires a
good knowledge of Maplnfo and coordinate
systems. If vector maps are used for GPS -
navigation, suppliers should be asked to provide
their maps with WGS-84 system. See Figure 2a)
for an example of a vector map.

3.2.2 Raster image as a base map

Raster images are mainly scanned images of
printed maps. They are ideal base maps if the
area of interest is fairly small in diameter (< 10
km). All the details in a printed map are included
in the raster image. If a colour scanner is used,
true colours of the printed map can be applied,
too. Raster images are used only as backdrops
onto which transparent vector layers are
superimposed. Raster image is registered by

»f vi'nr*' >Tee or more control points with known

Because the raster image consists of small dots,
re-sizing is limited by the resolution of the image.
The coordinate system, in which the original
material is created, cannot be changed either. If a
raster image is based on a system other than
WGS-84, a coordinate correction may have to be
performed to display the coordinates from GPS
at the right position in the map window. A simple
correction is presented in section 4.3.

Two other types of raster images, which are
potentially useful for safeguards purposes, are a
SPOT satellite image and an aerial photograph.
SPOT satellite images are supplied with the
requested coordinate system and they are already
in digital form. Aerial photographs do not have
any built-in coordinate system. Using these as
base maps requires either GPS -measurements
on the spot or some reference map where the
coordinates of the corresponding objects are
found. Figure 2b) is an example of a raster image.

a) b)

Figure 2. An example of a) a vector map and b) of a raster image. The top view has a scale which
is 3.7 times larger than the bottom one.

11
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4 SAHTI SATELLITE NAVIGATION SYSTEM

SAHTI system was built at STUK, Finland, by the aerosol laboratory. Radiation
measurement results and GPS co-ordinates have been combined in the laboratory
since 1993. These applications were based on retrospective desktop mapping.
Following the same ideas, a real-time navigation system, SAHTI, was developed
for in-field measurements and, later, for safeguards purposes under the Finnish
support programme to IAEA. The system consists of a GPS -receiver (Trimble,
Mobile GPS or SV-6) and a LapTop computer. The software is produced using
Visual Basic and MapBasic programming languages.

4.1 Overview of SAHTI software

The main body of the system, the SAHTI control
panel, performs coordinate acquisition, stores
time and coordinates into a file and passes the
information to the mapping application. This
program is known as SAHTI.exe. A MapBasic

program, known as SAHTI.mbx, runs within
Maplnfo and displays the position on a selected
base map. Some display settings can also be
performed in SAHTI.mbx program. A third part
of the system is known as IMPORT.exe, which
handles the viewing of previous measurements.
Figure 3 shows a layout of the whole system.

GPS RD-02

PC-computer

GPS

MS-Windows

IMPORT.exe

...

SAHTI.exe

Maplnfo

SAHTI.mbx

Figure 3. SAHTI system.

12
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4.1.1 SAHTI control panel, SAHTI.exe

This program communicates with a GPS -receiver
and displays position, time and status of the
receiver. There arc settings for SAHTI system
configuration (Basic SetUp in Options menu),
for save path (Save Path), file name and for map
selection list (Edit map list). Use ofMaplnfo and
Dose-rate :ncter (optional, Rados RD-02) can also
be confirmed through the "Options" -menu.
Figure 4 shows the layout of SAHTI.exe.

4.1.2 GPS application for Maplnfo,
SAHTI.mbx

When SAHTI.mbx is executing, a drop-down
menu, "GPS", appears in Maplnfo's menu bar.
The main task of this part of the system is to
display the position in the Maplnfo's map
window. When the "GPS" menu is selected, a
list of items appears. The symbol, that shows the
position, can be changed by selecting item "Edit
symbol". Co-ordinate correction can be per-

•Optiona

Latitude

Lonqitude

TimB

Help

No time yet

1 1

•

mm
Start - f

£mt |

On Top Cancel

Basic Setup
td i t map list
Dust: Rate

Basic Setup

flnmm pmt r.f1Mp~|

Comm. piotocol ITSIP I

Plot interval ||Q |

Map Dii

Mbx file

| o ,

|CAMAP3\

ISAHTI.MBX

j Cancel

|

1
I

Delete Add new

Give the whule

H aximum length 4

Select new .war file

aino.wor
eesli.woi
exwnple wnr
OPt.wor
liel_veK.wui
inc A wor
id»a_hLwui
map prei.woi

B e : [ELITE...|

1Z3C-S

• ddld
Q heta
Ö rab_codn
CJ tmrins
atyk

•

T

1 3
flK Dincel

Figure 4. SAHTI.exe. Selecting an item in the "Options" menu brings out new windows in which
the system can be modified (Save Path, Basic Setup, Edit map list). Selecting the item "Maplnfo"
confirms the use ofMaplnfo in the system and it starts automatically when positioning is started by
clicking the "Start" -button. Every time the co-ordinates are updated, information is passed to
SAHTI.mbx, using Windows DDE -link.
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formed by selecting item "Corrections" and
selecting a suitable correction in the corrections
window. Through the "Draw mode" item, the
display can be set in cumulative mode. The user
can mark positions that have special interest by
selecting item "Mark positions". Description for
a marked location can be typed into a text box,
which appears on the screen (max. 50 characters).
When all desired locations are marked, a Maplnfo
table or an ASCII file can be saved with a name
defined by the user. If the draw mode is changed
into cumulative mode while positions are being
marked, already marked positions must be saved
first. Old position data can be imported for
viewing purposes by selecting item "Show
Previous". Figure 5 shows the layout of
SAHTI.mbx.

4.1.3 Previous data viewer, IMPORT.exe

This program executes automatically when
"Show previous" is selected in Maplnfo's "GPS"
menu.

An ASCII file is opened for reading through a
standard Windows File Open dialog. The co-
ordinate correction which is used for a certain
map is applied when old data is imported. The
data is automaticly updated in Maplnfo's map
window. Figure 6 is the layout of IMPORT.e;'.e.

4.2 Starting positioning

Before starting the system, the user should ensure
that there are digital maps available of the area

-£oneclion
-Draw mode

Mark position
Import previous
Quit

p SJnTuTT. | riK I

r Finnish collection

T F.ee Lon i

(• None

•n Lat I

Symbol: || D I_±J

Coloi: ! • • • • _ £ ]

Sample

OK | | Cancel

ID

: (ilve the table name

Save Dolnts hlo a Table

Save paints Into an ASCII lite

Give lile name ||TM

Figure 5. A layout of SAHTI.mbx. A drop-down menu appears in Maplnfo when SAHTI.mbx is
executing. Several functions are performed by selecting an item in the drop-down menu. Follow the
lines to determine the function when a item is selected.
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of interest. Digital maps can also be produced
from paper maps by using a digital scanner and
Maplnfo.

Once the maps have been purchased or produced,
a Maplnfo workspace for navigation must be
prepared. A workspace is a set of map layers,
which are displayed in the way the user wants.
For creating a Maplnfo workspace, see Appendix
1.

Before starting the navigation, it should be
checked that the antenna can see enough open
sky (not too many buildings or trees around).
Because of signal attenuation, the accuracy of
positioning might be lower or the receiver might
not get signals from the satellites at all. Step-by-
step instructions for using the system are given
in Appendix 2.

After the program has been started, it may take
some 3 to 8 minutes before the coordinates appear
on the screen. This delay goes to when the
navigator finds three uscable satellites and
calculates the first position. The co-ordinates arc
updated in the SAHTI window with the interval
selected by the user. The title of the window
shows the status of the navigator. There is a label
with caption "HEALTH", appearing and
disappearing on the bottom of the SAHTI
window, showing that the communication is
working. When a sufficient number of satellites
is noticed by the GPS -receiver, the label on the
bottom of the window reads "OK" and the status
of the navigator changes to "Doing Position
Fixes". If Maplnfo is used, a symbol appears in

the map window, showing the current position
every time the coordinates arc updated. All the
coordinates arc stored in a file, which is defined
by the user. The file name consists of four
characters given by the user, the date with four
characters and an extension (e.g.
IAEA1906.WGS). When the position symbol
moves away from the area shown in current map
window, the view is automatically updated so that
the last position symbol is shown in the middle
of the map window. Navigation is finished by
quitting "GPS" -menu in Maplnfo and selecting
"exit" in SAHTI program.

4.3 Confirming the position on
the map

If the base map is used for the first time, the user
should confirm that the position obtained from
the GPS -receiver corresponds to the location
found on the base map. This is especially
important if the coordinate system is not based
on WGS-84, or has not been completely defined.
Confirmation is performed by letting SAHTI
system to run on one spot for a long time with
the plot interval of 10 seconds.The "Draw mode"
must be set in cumulative mode (setting in
Maplnfo, GPS menu). After about an hour, the
ccntroid of all measured positions is estimated
and the distance between the measured centroid
and the location on the map is measured using
Maplnfo's ruler tool. The ccntroid corresponds
to the real location in the nature with an accuracy
of 30 metres or better.

Open coordinate file

File: c:\nks\linja1.wgs

2G05_ap.wgs

Iinja2.wgs

L •"m

• •H

E3c: [ELITE

OK £ancel

1
_1
±

Import Previous Measurements

File spec: |c:\nks\linja1 .wgs

Ok; Quit

Correction |None

Figure 6. Layout ofIMPORT.exe. Data is read from an ASCII file with standard format. Symbols of
the old measurements are automatically added in the current Map window.
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If the ccntroid of all measurements is less than
50 m away from the corresponding position on
the map (measured with Maplnfo's ruler tool),
the map fits in its correct position well enough
and no correction is needed. If the centroid is
clearly further away from corresponding position
on the base map, a correction must be performed.

There are some simple methods to perform the
correction. The easiest method is a linear
correction, where the symbol is forced by a certain
number of metres in the right direction. In
Maplnfo's GPS menu there is a submenu for
corrections. Linear correction of given number
of metres is performed by selecting "Free
correction" and typing the distances into the text
boxes beside. The same correction parameters arc
applicable over 100 km away from the spot on
which the correction was defined.The same linear
correction parameters should be used every time

when the map is used. Therefore the correction
should be carefully recorded. "Finnish cor-
rection", in corrections window, is a local
correction applied only in Finland with the
Finnish base maps.

Especially for raster images, there is another
method. Once one spot has been determined with
GPS reliably (long time acquisition), the distance
between position according to GPS and correct
position on the map is measured with Maplnfo
(with the ruler tool). Raster Image Registration
in Maplnfo is changed to bring the map object at
the same position with the measured one. This is
performed by adding (or subtracting) the
differences into X and Y coordinates of Raster
Image control points, respectively. The advantage
in moving the whole map is that it only has to be
performed once. There is no need to remember
any correction parameters cither.

16
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PREPARATION OF MAPINFO APPENDIX 1

Maplnfo's workspace is a selection of maps in one or more map windows. Names of tables and
display settings (colour, region fill style, etc.) arc stored into a file with an extension ".WOR". You
can include in your workspace several map layers (vector and raster). It is recommended that the
bottom layer in map window it a large vector map, e.g. map of World or Europe. Preparation includes
following steps:

1. Make sure that all the maps you want to include arc stored on the hard disk of your computer.
2. Start MapInfo.
3. Select Open a Table in File menu. Through the dialog which appears, open a map which you

want to include in your workspace (largest map first, e.g. map of world). Repeat until all
desired maps are opened.

File > Open Table

File Name:

pad_tiet.tab

File Format:

Open Table

Directories:
c:\nks

Open

2G05_ap.tab
hexa.tab
jätealue, tab
kartalue.tab
pad_ joet. tab
pad^jär.tab

! Dad tlet. tab i
svomod3.tab

f.

_
±

f^nks
Cancel

Drives:

MapInfo

Display table in window

S c: elite 510

17
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APPENDIX 1 PREPARATION OF MAPINFO

4. If any vector layers arc included, you can change the display style.

Map > Layer control > display > display mode

Layer:

Layer Control

Zoom
Visible Editable Selectable Layered

I Cosmetic Layer
Ind. Value with Luokka

PAD_JAR
PAD JOET

X
X

X
X

Ix Visible
F Editable
[x Selectable
f~ Zoom Layer

Settings —

Djsplay... 1 Label... Th&jftatic...- Add... Remove

r Reorder-

Mi> .1 Down ;

OK Cancel

.— PAD_TIET Display Options

Zoom Layering

f~ Display within zoom range:

Mia zoom: | f^

1 km

F Show Une Direction
F ShowN.odes
P Show Centroids

OK i Cancel :

OK Cancel

18
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PREPARATION OF MAPINFO

Here you can change the style of the objects in the layer (style override)

Map > Create Thematic map

APPENDIX 1

Create-Thematic Map - Step 1 of 3

Pick a Type of Thematic Map:

Graduated

Bi t Chans

Dot Density

P i * Charts

Individual

| Cancel ] | INext >

3 Create Thematic Map - Step 2 of 3

Select a Table and a Field:

P~ ignore Zeroes or Blanks

Cancel | | < Eack | | Next >

Create Thematic Map -Step 3 of 3

Preview:

PAD_TIET by Luokka

1 (26)
2 (57)
3 (532)

i Customize

Legend Label Older

f Ascending C Descending

Styles... ] j
j i

Legend... !

| Cancel | | < jack j | lÖKJ |

Here objects are coloured or styled according to a value of selected variable (e.g. colour of the road
corresponds tr •: road classification)

19
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APPENDIX 1 PREPARATION OF MAPINFO

5. Set the display limits for each layer. This means to set the smallest and the largest zoom where
the particular map is visible. Vector layers with large number of details and raster layers must
become visible only when the scale (the zoom) of a map window is so that all details are
visible.

Map > Layer control > display > zoom layering

PAD TIET Display Options

Display Mode--

P Style Override

'Zoom Layering) - ~

fx Display within zoom range:

Min. zoom: |3 km

Masi. zoom: |1QQ| km

V Show Line Direction
f". Show Modes
F" Show Cenlroids

OK | Cancel *

20
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PREPARATION OF MAPINFO APPENDIX 1

6. Zoom and move the map so that the area of interest is in the middle of the map window.

MapInfo-[PAD TIET.PAD_JAR....B21430H Map]
File Edit Objects Query lable Options VVinilow M°P HelP

A

\ .

J îTjK : V

IZoom. 4 51 km ;Ec£ting. tlone

7. When all modifications are performed, save the workspace

File > Save workspace...

rf=ihi
File Name:

I I sample), wor

Save Workspace

Directories:
c:\map3

map3
] data
] hesa
] mb_code
] (rados

List Files of Type:: .Drives:

(Workspace (-.worj [±|: | [ s l c: elite 510

OK 1

Cancel
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A P P E N D I X 2 STEP-BY-STEP INSTRUCTION OF USING SAHTI SYSTEM WITH PCMCIA GPS

The following example assumes that a suitable Maplnfo workspace is prepared earlier. Starting the
system is performed according to the following steps:

1. Check that the PCMCIA card is in the slot and attach the antenna cable to the connector in the
card.

2. Check that Maplnfo's security key, if it is needed to run your software, is attached to the
parallel port of the computer.

3. Turn on the computer and make sure that the PCMCIA card is set up properly by automatic
PCMCIA card drivers (a sound signal).

4. Place the antenna on an unobscured surface. Check that there is not many high buildings or
trees covering open sky.

5. Start Windows and program "SAHTI" in program group GPS.
6. A window as follows appears.

7.

SÄHTI
Options Help

'. Latitude S-'I
%^UM^h- - -- -«•••-
j,L6ngrtudeU

ftMBSlS^SPo time yet
Exit

£3 On Top

Check the "Basic Setup" for following parameters. Alternative values may be changed by
typing new values in the text boxes.

Options > Basic Setup

Basic Setup

Comk}ppitJ:yr pÖ ^ V ' ;

Com;n. protocol

käp^Öir | | l

A TSIP

10
'•'§$%

C:\MAP3\

SAHTI.MBX

OK !

-;?Pi

Cancel 1

ti

I
CM
yt
%

The port must be "COM2" and protocol must be "TSIP" (Trimble Standard Interface Protocol).
Map directory is the directory, where Maplnfo and the required MapBasic programs are stored.
Suitable plot interval is 10 (the interval of passing data to Maplnfo, approximately in seconds).
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8. If the system is used for the first time, you must add a new Maplnfo workspace in the system.

Options > Edit Map list

Edit map list

1
SUOMI
VESIVEH

Delete

''-, - \ •'' . '> - V" ' ••

Add new'

S ,""'"''>'},••

Selecting "Add new", brings out a standard Windows file open dialog, through which a prepared
Maplnfo workspace (Extension ".WOR") is added in the system,

Select new .wor file

C:\MAP3\EXAMPLE.W0R

gps.woi
hel_vek.wor
iaea.wor
iaea_hl.wor
map pres.wor
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9. Click the check box "On Top" to set the SAHTI window to stay always on top.
10. Confirm that you are using Maplnfo to display the position on a digital map.

Options > Maplnfo

11. Start navigation by clicking the start button.

12. Select a suitable base map from the list. Maplnfo starts then automatically with selected
workspace.

Co-ordinates should be updated first time at the latest after 5 minutes. If there is no update, check
that GPS is receiving signals from satellites (status on the top of the SAHTI window) and make sure
that antenna is placed properly.

Once the navigation is working properly, the co-ordinate correction must be set as defined for the
base map. If the correction is not defined yet, it should be performed to obtain higher accuracy
navigation. Section 4.3. explains the principles of co-ordinate correction. Defining of the correction
is performed as follows:

1. Set the draw mode to cumulative through GPS menu in Maplnfo

GPS > Draw mode

Cumulative display is off

I* Sffiffll" I

Click on the check box to change the mode to cumulative.

2. After about an hour, re-scale the map window so that all measured positions are seen (zoom
tools in main tool box). The centroid of all measurements is estimated and the distance between
the measured centroid and real location on the map is measured using Maplnfo's ruler tool (in
the main tool box). In this example we assume that the distance is 150 m west and 50 m north.

1 Ccntroitl of measurements
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3. Linear correction: Select "Corrections" in GPS menu.

GPS > Corrections

•
Ö

®
0

1

• Correction

Finnish coirection

Free

None

OK !

Lon l 1 5 0 m

v •••• . I

L a t l 5 0 ) m >

Choose "Free correction". Type 150 in the text box with label Lon and -30 in the text box with the
label Lat. Click OK button.

4. Method for raster a image as a base map

Raster image can be moved into right position by changing the values for Raster Image Registration
in Maplnfo. This is possible if the coordinates of control points are expressed in meters, feet etc. In
this case you must subtract 150 m from X co-ordinate and add 30 m to Y co-ordinate.

Table > Raster > Modify Image Registration

image Registration

Label

Pt2
Pt3
PU

X Coord Y Coord
2550000.00 E800000.00
2550000.00
2560000.00
2560000.00

6790000.00
6800000.00
6790000.00

Error (pixels)
Bill

0
0
0

Click on image to modify points coordinates.

Tollmen «

Edit..

Remove

Goto -

Edit Control Point.

Edit the information for this control point

Label:

MapX:

MäpY:

Image X:

Image Y:

PM :

|2550000.00 s m

6800000.00 m

o

' ' ' ' ' \ <
| OK \ Cancel j ; , ' ; - , ;
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Locations with special interest (e.g. sampling point) can be marked and co-ordinate information
saved in ASCII file and Maplnfo table. At first the draw mode must be non-cumulative. Marking
and saving goes the following way:

1. Wait that the co-ordinates update while you stay on the interesting spot. Select "Mark" in
GPS menu.

GPS > Mark positions > Mark

A dialog where you can type 50 characters long description appears. Click OK and a red spherical
symbol, which corresponds the marked location, appears in the map window.

2. Repeat the procedure above as many times as needed.

3. Save an ASCII file selecting "Save an ASCII file" in GPS menu.

GPS > Mark positions > Save an ASCII File

Save points into an ASCII file

Give file name Jsamples.TXT

You can type the name (max. 8 characters and the extension) in the text box. The file is saved in the
"USER" directory in your Maplnfo directory.
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4. Save a Maplnfo table selecting "Save a Table" in GPS menu.

GPS > Mark positions > Save a Table

Give the table name Samples

As above, you can type the name (max. 8 characters, NO extension) in the text box. The table is
saved in the "USER" directory in your Maplnfo directory.

Finishing the navigation is performed in the following way:

1. In Maplnfo select "Quit" in GPS menu

2. Click buttons "Stop" and then "Exit" in SAHTI window.
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